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1.1.1 Python i& S5

Python & —FfEF- &5 & %1ES . 7 LT Windows. Linux fl Mac & . Python i&
FARE ST R AR L W AR A S b AUl 2 R 1A S A L SE )
—~ifig , Python i & B 52 BLACRS 1178 & & 8 1Y . Python AHXT T HAh ga #2158 5 K Uk, A LU
TILME A

(1) Python ZFFIEM W2 28 % . R, B R CIRACHS , 3 R i H P #fml LR
FPFEACHS . Python WY IR I ZE R P 02 ff F Python 45 FYACAD 2 TR . Python i B 4
RIS TR Y . TP IR IE A G5 T 2, THIRUARE R0 5 9% SR PF 2 AW & U R 2 80 IT
TR AR A Al 2 G 35 3K 44 5 Python R XH —FE T, BEEJFIRE X 2% . H P i H Python i
PR SE KA A O IT AN 2SR ] 9% A AL AS FH 0 RO ] 80, B 4 S 35 M
&, Python L 2251,

(2) WHEF R, FEGR C/C++ Java.C# i 5 M b, Python XA % 2 1y 225Kk 1k
FIR AKX Bl ST P AE 4R S A B LR AR A, AN I AE AR R T LB 2 K2 M5 77,

(3) Python BEHIET . X HITULH 9, E48 Python B30, bk 118 2K )= 40
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5, b Python 2 A 2 & BN AF (72205 B 3 40 Bc . AT 20 B S B0 .

(4) Python i BALE BBV . MEALE S — A2 BT 6 1 TR T
Python tB A 4h

(5) Python ZHEI X R MAEIET . H X R ERR R BIET — R EZ 0T, &
T FF S rh AR B S HE B DL . Python SRR 1) X6 42, {H 8 A i il 4eff 1 1 X6F 42

(6) Btk AR Z . Python MRBIH AR 2, FEARSIEL T T A A9 % DL A9 2 g, DATRT 2R 1 7 4% 52
B, B 1) 3D KB L, {5 Bl Python BHUER T DL #A 5 . Python #f X & & R 4T,
BT Python B I 24 DAL AN AR 256 = L &S Sk E i, Horh st
Google,Facebook ,Microsoft 254 F 3k, B & — L6 /N A A T BE , Python £ A2t A X} )7
MR B A AT REAS 1k — AR,

(7) AJY ks . Python BRI MK B AL [, Python B WAL T i £
B OFR R PR R S SE PERE 55 T SCF T/ O G A /i 1) VBB THE L GUTL M 4% 4 72 503 e
Vi 0] SCARAE 45 26 843 I FH 3 5% . 3K S8 28 P 1 i )2 AR R — 22 #B & ] Python %5 (1
WARZ C/CH+HIEFME R, M E—BOCHAUS Iz 17 3R SR i nl LUE ] C/CH+ i
L ARG 7E Python I EAT. Python MK RIFMP M 7F — & B Logth T8
A7 A% 1 R A

1.1.2 Python ZafEIABEN HL .

%5 Python # /¥, i] LI7E Python [ Y58 B xCF T K 388 FR B 4T o it T 1 4l B T 2 30
SR S 7R DI REFIHRAE DI BE AN 5 K, Python F 1 il DLFE SR = J7 S i L b T R 3R 95 b 2 5 441)
4 PyCharm, #RJ5 ¥4 Ji] Python Y REARIZFTRESY o AR B G N2 BE AT LULE Python F 4 (Y
TP RIS AT AT LATESE =05 TP R 47, th B 5 ARG A S W24 AATIRGE

[vmlP

1. % 3% Python

Python & 84 28 44, H 7 Al L2 Python W'E M I B #% F £ Python ZfEF, &
s¢ Python BB J7 W% https://www. python. org/downloads/, . F 8 A 1-1 frs .,
LU T HAR- 6 AR MA R 2R . oA 2 3. 9.6, Python 223 FE 7 5 H

e python

Download the latest version for Windows

Dowrload Python 396
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ZS[AIAN KRR 3.9, 6 A 24, 83MB. B Downloads, 1 DL 4% B4 [7] &2 48 T /9 4 > hit
A [ Python G H2IF . N2k Python 24 ¥ I MRS A O M3HAHLIE 32 fi6 2 64 i, i
BEHN T AL, 0 5 Windows installer (64-bin) B DA F #% 64 {7 B 7] P47 2226 72 ¢
— kBTN A] ; Fd; Windows embeddable package(64-bit) s f#i H zip #5146

B B A W] LA B i A CER 180 B At 1 Bz AR 7 v

Pt web-based installer 3758 1

P 46 22 3% R UL T R — 23 5 G B R L T BEIC R R L IE Y Python %%
£, Python %23 B J7 o T DA AE [ A B9 — 2678 800 o b % 3, 0] 40 7E 48 R 515 A

“Python T #”, 5t Al LL#RF|F k4%
DL B3 B iz

Z1T Python M43 FE)F python-3. 9. 6-amd64. exe, 7E55 1 A6, & 1-2 fr

/j?,)iﬁj Add Python 3.9 to PATH, 2.1 Customize installation ¥l ; 7558 2 £, A& A
I, Hor pip W& T T F 858 =7 Python 1, B Next 8l A% 3 2, A # Install
for all users Ji, WE 1-3 i P B LR BAE AE WL LER RGP . i Install $Z41

Fih%de, LR

H #4473 Windows B EE 45§ PATH ", Python £~ A AT LL

-G L. BT NA . Python 1% % H 5% Scripts T B pip. exe il pip3.

exe SCIF T F 8O A 2 3

S Python 3.9.6 (64-bit) Setup - x
’ Install Python 3.9.6 (64-bit)
Select Install Now to install Python with default settings. or choose
Customize to enable or disable features.
- Install Now
CAUsers\lenovo\AppData\Local\Programs\Python\Python39
4 Includes IDLE, pip and documentation
Creates shortcuts and file associations
—» Customize installation
Choose location and features
python
for B4 Install launcher for all users {recommended)
windows /Add Python 3.9 to PATH Cancel
& 1-2 Python %255 1 4
S+ Python 3.9.6 (64-bit) Setup - x
J Advanced Options
E Ins__til‘:l _ﬂ_:n_r_a_ll usersl
[ Assodiate files with Python (requires the py launcher)
B4 Create shortcuts for installed applications
B4 Add Python to environment variables
A Precompile standard library
4 [ Download debugging symbeols
< [0 Download debug binaries (requires V'S 2017 or later)
Customize install location
ID:\Pngram Files\Python39 J Browse
python
for
windows | e | [ Gl
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GRSEE T MK —F Python B EHEEIEH 217, M Windows I L& 32 )7 4k
F| Python H C By I & ¥ 5 IDLE, f &l 1-4 s, 78 “>>>" 478 P A “1+ 27 803
“print("hello") ”F#4% Enter 8, WK AEIR [0l 3 54 # hello, ] Python i£471E % .

P A IDLE Shell 3.9.6 - o X
Python 3.9 Fle Edit Shel Debug Options Window Help
| [l Python 3.9.6 (tags/v3.9.6:db3ff76, Jun 28 2021, 1
: 5:26:21) [MSC v. 1929 64 bit (AMD64)] on win32
b IDLE (Python 3.9 64-bit) Type "help”, "copyright”, “credits” or “license()
" for more information.
1.9 (64-bit > 142
9 (b4-bit) 3 . -
9 Manuals (64-bit) }:;;lgrlnt( hello')
222
b Python 3.9 Module Docs (64-bit) 7 Cokd

E 1-4 i Python

2. REMEUESG

LA 5E Python Ji o 35 TR E 2R SRR A XA ., AP HAMAA NumPy,
matplotlib,SciPy.SymPy. openpyxl,PyQt5 Ml pyinstaller, &4 0] DL B 42 %8, tyv] A —
WL Z A, T A4 Windows R 48 % 3% NumPy 1920 88, DUAE 3 05 s 17
Windows B emd 4728 O, % A “pip install numpy” J5 % Enter 58 7] L1 % %% NumPy 13,
WK 1-5 Fros, WA LA “pip install numpy matplotlib scipy sympy openpyxl pyqt5
pyinstaller”fig & — K Z4 2 A, WARZEHEAL, 7T LU#E H “pip uninstall numpy” 4.

BEE: SS8TE — o x
Microsoft ¥Windows [H,E{Zfi 10. 0. 18043, 1110] ~
{(¢) Microsoft Corporation. {REBATEAA. [l

C:\WINDOWS\system32>pip install numpy
Collecting numpy

Downloading n -1. 21, 1-cp39-cp33-win_amd64. whl (14. 0 NB)
AR ;. 0 1: 030 KB/

Installing collected packages: numpy
Successfully installed numpy-1.21.1

C:\WINDOWS\system32>

15 AP

a2 B4 LB, U PyQts A 53MB, Ui SR N E AN R 3 E R 2 PyQts Tl fig
e g g, mT LU FH B 4% 0 3t T 2% 49 a0 3 18 K OB AR Il L 4 SR .

pip install pygt5 - i https://pypi.tuna. tsinghua. edu. cn/simple

3. 2%t PyCharm

MR HUE 9 S R A F2 )7, 7 Python HAR P KA EE T SACH Z /T LI, HXF T %
b R ok U g B R Y LA R 2 7F Python H Y B T & 3845 vh 2 5 (RS 5 A 2L 42
BEULIN 1 e R 2 5 T [ X R B AR, TC e R AN 4 s T BRI 2 A 1R B R R D) BB L i
AEAN I EABEMIIGEERR K. PyCharm J& —A>% T4 Python 71 /) 4 BT & 3745 (IDE) ,
WA —BET LB P A A Python i 5 7 & B4 & RCR 0 T B, Hoan ik 5 2 &
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So I H A AR Bk R BB IR R L B 5 A, BT R RO #E ] A . PyCharm W] DL 4%
W Python W f# B4 . i217 Python 27 . B K HE = Python W FF ZRUCR .

PyCharm Hi Jetbrains 2 & & &, 0] UL 7 https://www. jetbrains. com/pycharm/
download | F % PyCharm, W& 1-6 fi/~, PyCharm & W4 A4S . 43 ] J& Professional (%
SO FI Community BRI o Mk b W 2% 1 5+ XU 58 42 5 98 19, B idi Community
T B9 Download #2417 LA F 24t X it PyCharm., 7E4## &R 5% i A “PyCharm T 7.t 7]

PAAE Al T #F & 48] PyCharm T #0554 .

Windows macQOS

Professional

For both Scientific and Web
Python development. With
HTML, JS, and SQL support.

Version: 2021.1.3
Build: 211.7628.24
30 June 2021

System requirements

Download

Installation Instructions Free trial

K 1-6 F#k PyCharm W Ifi

Download PyCharm

Community

For pure Python development

Download

Free, open-source

DA B 53 B 33847 T 3 23R )T pycharm-community-2021. 1. 3. exe (B2 ¥ T 2 [ it
ARAHE S AR LRSS 1 A% B IEAE 8 o Next $4HL L R 55 2 A28 3% X ih HE o i3 8 40 2%
AR AR 1-7 Fios . Bl Next 3L 7655 3 A2 X IEHE Hh 20 26 <. py 30, W& 1-8 TR,
¥ py X5 PyCharm JCBE, WEAREE I HLUZ 64 A7 R 40, W24 % 64-bit launcher, H
i Next #4765 4 D BEMIEHE T , By Install HIF UG 2655 . Fo)5 Hili Finish #4158

B PyCharm Community Edition Setup

. Choose Install Location
Choose the folder in which to install PyCharm Community Edition.

- X

Setup will install PyCharm C: ity Edition in the following folder. To install in a different

Destination Folder

folder, dick Browse and select another folder. Click Next to continue.

[0 Program Fies VJetrains PyCharm Community Editon 2021 1] | Browse... |

Space required: 931.9 MB
Space available: 96.4 GB

| <t [he> ][ o |

Bl 1-7  PyCharm M5 2 A% %E X G HE
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B PyCharm Community Edition Setup - x
Installation Oplions
Configure your PyCharm Community Edition installation
Create Desktop Shortout Update PATH variable (restart needed)
[ 64-bit launcher [ Add taunchers dir to the PATH
Update context menu
[[] Add "Open Folder as Project”
Create Assodations
Moy
<Back || Next > [ Cancel

% 1-8  PyCharm (%5 3 4> 2¢ % XHEHE

/%5 1.2 Python FF % TR 155 {5 F E

1.2.1 Python [ 458K IF R EAES

TE4% 4% Python B, [ B A1 25 2056 — AN R I & 3858 IDLE, B & —> Python Shell (7]
DIAESTIT 89 IDLE % HAAREE & D AE“>>>" 388 T & 47 A Python T2 7 . B A —
175 #% Enter #, Python BT X — 47N %, ATmFATC 20 IDLE fa it 1 f/f 509 i
) ARAESE BRI R, T B S 2 AT A B AR S A JE — B RAT BT A B AR L DR g
TR O ] DA A A — A SO DR A7 X 26 40AD , T 20 i 5 58 BUE — AT

¢ IDLE F % [ A3 R E % # File>New File #iy 4 #4447 FF Python B ST 1, 4N
K 1-9 Fios ez E A b HiE9 S Python A1, i A —47 A )5 4% Enter 8,5 H 345 5
T—47. G gksti A . B 3R ¥ File—>Save J&§ . B4 32 H1 Run—>Run Module 8#% F5
BERLAT LLIRAT L 45 R KE A Shell 2R, SCHFE 1 EY Edit Ml Format 2% B2 5 H A9 2R 4L
Edit 3R T 3 A 3k, Format 328 T4 R 7, 4] 1 f# A Format—Indent Region HJ
PIF 3 g A g k. B SR B Options—Configure IDLE 1] LA Xt Python #4714k & , %)
T 5 e g AR AR 0 AR AR RN S A 0 b o A R PR BB A

TESCAR 6T 11 i AT T — BORI 4 F5 S 478 7 . 78 Shell % H b a] LU 1 — 15 3%
wiE 1-9 Fis.

#Demo 1 _1.py

print('"' * 20)

print('' % 10 + 'HIE')
print('"' * 15 + '———— FIER")

print('FHHA e, Ab AL B WG 1)
print("RRKMF, LEHMEZ D)
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A a.py - Di/python_book/a.py (3.9.6) = o X A IDLE Shell 3.9.6 - [m] b4
File Edit Format Run Options Window Help Eile Edit Shell Debug QOptions Window Help
#Demo 1_1.py o I ECRN
print(" = * 20) ======RESTART: D:/python_book/a. py ========
print(C ’ * 10 + ' {FHE’) P
print " ' * 15 + ' ——fikHA) RN S ¥E

i g e I LRIRASDERE, Abubidm .
print ( FUAGERE, AbAbigmi. ) ORI, (EEIE D,
print ( BORMAIS, fE&MZED. ") | |7 I
B Ln:8 Cok:0 In:8 Coko

K 1-9  Python U KA1 Shell & 1

TESCHEE 10 HR 3T IR AR 5L 45 Demol 2. py, W R 1 AOARAS , 3% F5 #5877, 58—
T, SRR 2 B iR S % AR 4 I & ( Python &4 5 PyQt nl AL i FE1EAR )

import sys # Demol 2.py
from PyQt5 import QtCore, QtGui, QtWidgets

app = QtWidgets.QApplication(sys.argv)
myWindow = QtWidgets.QWidget()
nyWindow. setWindowTitle( 'Demol 2')
myWindow. resize(500,400)

myButton = QtWidgets.QPushButton(myWindow)
myButton. setGeometry(150,300,150,50)
myButton. setText ('K [4]")

strl 1 = ''%10 + '"BEFEAZEH\n'
strl 2 = "' 15 + '——— «JLI T >l \n'
strl_3 v
TAEEFEMTETE, BRI, BR S5 \n\

TA7 4875, Bug fi] 40 5T . \n\

P B ERE, A, & Wi \n\
TR, KRR, B B \n\
ARRTE &, MEA TH T-47 . \n\

RE AT K BRI AL, A8 )7 5L, IE B

e

peo = strl_1+strl_2+strl 3

myLabel = QtWidgets.QLabel (myWindow)
myLabel. setText(peo)

myLabel. setGeometry(50,10,400,300)

font = QtGui.QFont()

font. setPointSize(15)

nyLabel. setFont(font)

myButton. setFont(font)

myButton. clicked. connect(myWindow. close)
myWindow. show( )

sys. exit(app. exec())
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1.2.2 PyCharm £ H- % 055

Bfi PyCharm BN Python M5 BT & 58, 75 20K Python #¢ & i PyCharm 1 fif £
#% . Jadh PyCharm, W& 1-10 FF 75, 76 3K 30 %F 05 HE 0 #%E £ New Project i, 3 H} New
Porject 1% & X IEHE , 7E Location " AT H SCF B R F7 B8 A2 IZ B AR 7 B2 R &S B AR,
New environment using, J & # Virtualenv, )\ Base interpreter H % #& Python [ ff Bt 28
python. exe, s #% Inherit global site-packages fll Make available to all projects, ¥ B 284 3%
ML B Y HT I H L IR E N TR A I E . &S i Create # L A

- N
PyCharm H & ¥ 45% .
B New Project = o %
Location: | D\Python\sor
B Welcome to PyCharm R ¥ Rt
O New environment using &, Virtualeny -
g e Welcome to PyCharm Location: DAPythoryedveny
202113
Create a new project to start from scratch O Jolerposhac: D\Progeeen FleeFythordépydonans = Jj ..
Projerts Open existing project from disk or version cantrol, Inherit global site-packages
2 Make available to all projects
Plugins + P Irterpreter <No interpreters
Create a main.py welc i
Leam PyCharm  New Project Open Get from VCS RS TR Pl e e st
o =

K 1-10 Bl & Python fif B4y

PyCharm 1E % J& 3 J5 , 5235 o w] DL B8 18 9 28 B85 B 19 Python f# B 2% . BR3¢
A File—>Settings ] FF 5 & X i HE , B 2201 H T B9 % B 2% Python Interpreter, 2R 5 M5
4711 Python Interpreter 5 [l %) & %4, E£E“Add---”, L H BN Python ff B 2% 09 X 35 HE
WmE 1-11 frR ., FELAMES: System Interpreter, Lo 5] Interpreter J&5 f = #5243 HY
PE#E Python fif B 2% 09 XTIEHE . 3K 3] Python %3¢ H 52 T 1 python. exe U, iy OK 4,
o] 21 1% B X HE A7 I BOR T AR RN S RIF A, &E T OK 8 5CH Bt i XF

TEAE

B Add Python Interpreter jEM&iPﬁmlmupmn x |
2 Conda Environment | O Conda Emiranment
B Pipeny Environment B Pipeny Emaranment
oK Cancel EN o
1-11  #$% Python fiff B 25 4 i fiE

# A PyCharm J5 . 8.5 File>New 3 H, SR J5 £ £ Python File. fij A X444 332 Enter

B J5 H 57 Python 7 30 i AURD S L 2

BATRE Y E R 38 Run—> Run--- 7 & 5 1 %

XF R A S BERT 3 HY Python fif B g iz 472 .
TE S 2 R v AR METC A A8 B | ok ORI 28 1 A SO B DAY I Rl 5 A A 48 3O AR

B, PyCharm $2fit 1 X SET)6E .

6 S B AR B 7 Mac G Cmd+
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F ## ., 7F Windows fl Linux RG] Curl+F 8 758 A0 H 48 R AU Bt . 7 Mac &
%irp il Cmd+ Shift+F ##, 7€ Windows I Linux R H i F Ctrl+Shift+F ##; B4R
21 Mac RGP Cmd+ 0O 4, 7 Windows #1 Linux RGP {# A Ctrl+N 4 ; TR
S LT Mac RGPl ] Cmd—+ Shift+ O £, 7F Windows 1 Linux &% H i [ Ctrl+ Shift+
N s AR AN T A R 0 SO R AU B A B4R W AR PR Shif 8, ) fff
FHUATR P 4 o A7 Pl 5 0. BT AR 78 5 0 A WAL B, 7E Mac RG] Cmd #, 76
Windows 1 Linux R G AL Corl AL, AR5 B A8 i 54038 7 e sisC A Al +
F7 85 A AW EC ] Shift+ Ale+-C 8, 80 76 £33 A Hiifi View—>RecentChanges;
BEII SO Mac RGP Cmd+E £, 7 Windows fll Linux 24 i J§ Ctrl+E
Lo H T B 2R b iy View > RecentFiles; 22 W Bk ¥ J5 78 5 it Ui s b wip o 15 R 7
Mac 24 H i Cmd+ “[ 748 5{ Cmd+“ 178, 7F Windows 1 Linux & &t i A Ctrl+
Alt+“<"8 ey Cerl+ Ale+“—"4,

#8513 EESREEA

BN A 5 2075 2 R Uk Python 40 7 1 10— 26 L 452 U T 5L 7 — B, %y
Python % F AAUHT U e S B . A5 JJ5 26/ BEAR Python 48 FEHY — 26 3 ail 1R, &2
A 8 i WS K BI04 SR B Ak R B Rk 5 4 S0
) B B 1 — 3 T B

1.3.1 AT E X

i R KA TP Y 72 i (variable) FIR (VR 2 ACHS FHAS 55 2 A A5 R AR , A8 & mT L) 24 fi
JAF A B 1 — 455 . Python Hal Lk ] — A28 & 76 A [a] s 20 4% 2 AN [R) 28 2 11 440 L (R
ANBe R i A2 2 A Hidis . AR B AR 2 — AN B

# Python [ Shell T AW TS, 5 1 A7RIE 2 17, A& 2 AIAS & b 5 5 A7 i
BF 2 R 5, A4 1H3 THRSE AR BY 458 53 55 4 779 printO BRI a b F1 e AY{E, A
555 A7H printO pREAYIR BE AT LLE H a b Al ¢ BIES AR 2.5 f1 4, RS H g« =38R
WRAE 4 =" A7 0 B E RIA XMW ER S =" A8 &, )28 g F 19 N 5% AT L 2R b
=" =" A AR AR T = A R IR U

>>>a = 2

>>>Db =5

>>>c = 1+3
>>> print(a, b, c)
254

U W N

HAR T IZ =" PN A ERA RN TH 1A a=2 FZE 2 4] b=
5, THEAEHLAL B PRI WA G2 532 ST 7E WA T RE A4S 25 1, 20 0l 0 S EUfE 2 5L SRR B
SREE 2 FNC SR 5 A9 N AF 25 1] A S A S k3 S0 28 & a AT by X T4 3 AJ e=1+3,
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JE S E AR ITREWIAS 23 (8], 43 S SR BUE 1 F 3L 8K 5 1 3 A CPU L iff 7 1+3 32
B RN AL BRIG AR A R TERE— B B 4 B, 8 4 g B 205X A B s Rl B 4R 4 BT
TE [ N A7 25 8] (9 62 46 ok IR (B 245 728 & 0 28 4 1719 print(a, b, o) BIRBUZE L a b.c Frid sk
PR A7 itk o DA PR A RIS BROGE 0 e 1k %) 1 5 i

X F PUAE A A A B0 A S 4 Mok PT DL G id O sRERIRER . 7F Shell Hrgk2ifi A Q1R
A% AT LU B 2 A5 a 19 N A7 M hk 2 A ), 8008 5 RIS B b 1 P9 A7 Hiu ik 2 4 [
ML B 4 RS & ¢ 9N AE bR R AR R A

6 >>> 1d(2), id(a)
7 (140715084994240, 140715084994240)
8 >>> 1d(5), id(b)
9 (140715084994336, 140715084994336)
10 >>> id(4), id(c)
11 (140715084994304, 140715084994304)

7 Shell P 4kZ i AT NS, HApS 124708 a = a+ 6, 7ERTA M 1 TP E 4
¥ 2 Wy TR a, 18 a=at6 BEIE =" at6.M85 8. K54 8 EHMAEL a,
a MEAE R T 8, S 13 ATAIZE 14 AT LA a MERE 8. CA&AE2 T, 1217 a=at6
A TS B SR N AE T T RE — A 23 (B A7 A6 6, SR S5 AR I a 48 ) 19 P9 AF 25 (8] A9 {6 GX A
H& ) MNAEZS R 6 2 A CPU H L, 1547 2+ 6 BT A 145 1 8, 4R 5 76 I A7 25 )
T RE— 23 ] 4 A5 S 8 A4t 33X AN 8 s 8] v o 3l o (B 4R A =7 K 25 21 8 19 77 it Ml ik
WKL AS a0 a DD AFE W 2 MAE G hE , BT DL a WE I )5 A2 8Ll 28 15 17 M5 16 17
B A LA L8 Tl a RN JEAREI A . 25 17 4710 a=a+b+c, Seit B« ="
fi Rk atbrc WM. BT adgim 8.b 4517 5.c 1A 4,CPU NI LI 8.5 Fl 4,
SERL 8544 MTHE KA R 17 RAEAENAE D . B IR HAE 4 2 SRR 4528 17 N
A hE 38 3 25 20 ATARRSAIEE 21 A7 AR A AT LA Y, A8 B a FVECE 17 A9 k2 AR W] Y

12 >>>a = at6

13 >>> print(a)

14 8

15 >>> id(8),id(a)

16 (140715084994432, 140715084994432)
17 >>>a = atb+tc

18 >>> print(a)

19 17

20 >>> 1id(17), id(a)

21  (140715084994720, 140715084994720)

1.3.2 BEMEX

Python 718 B2 (0 T /R LB 7501 S8 44 BRI 0 BT JLO T A 0
» Python X488 B A FRIG /NG 0 A T a P4 IR 045 B



